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Resumo:O presente trabalho tem por objetivo apresentar um tutorial do SAP 2000 v.18 - 

Structural Analisys Program, para análise estrutural de um pórtico de concreto. O SAP 2000 

é um software para análise estrutural utilizando o método dos elementos finitos, desenvolvido 

pela empresa americana CSI – Computers&Structures Inc. e comercializado no Brasil pela 

empresa Multiplus Softwares Técnicos in. O SAP 2000 é amplamente utilizado na análise 

estrutural de edificações de pequeno e grande porte, bem como pontes, viadutos, barragens, 

entre outras estruturas. Apesar de ser uma importante ferramenta de análise, observa-se a 

dificuldade dos alunos de Engenharia Civil no aprendizado de tal programa, como também a 

escassez de material em português que apresente de forma didática alguns comandos básicos 

e tutorais de auxílio para utilização do programa. Visando contribuir para diminuir essas 

dificuldades, desenvolveu-se o presente trabalho, no qual foi realizada a análise de uma 

edificação comercial de dois pavimentos, construída em concreto, visando encontrar as 

reações nos apoios, valores máximos de deflexão, momento fletor e esforço cortante nas 

lajes, vigas e pilares que compõe a estrutura a fim de estudar seu comportamento. 

Palavras-chave: SAP 2000, Análise Estrutural, Pórtico 3D. 

 

1.  INTRODUÇÃO 

       A fase de análise estrutural é importante para se obter a idealização do comportamento da 

estrutura para os diferentes carregamentos que a mesma possa ser exposta em situações reais. 

Para se alcançar essa idealização se utiliza de métodos numéricos, pois a obtenção de soluções 

analíticas exatas para estruturas complexas é praticamente impossível. Atualmente a aplicação 

do método numérico conhecido como Método dos Elementos Finitos (MEF) em associação 

com computadores com elevada capacidade de processamento para conseguir soluções 

aproximadas, tem sido amplamente utilizada. 

       O SAP 2000 é um software de análise estrutural amplamente utilizado por profissionais 

da área de Engenharia e que apresenta excelentes resultados. Está baseado no Método dos 

Elementos finitos (MEF), que implica na divisão do domínio a ser analisado em subdomínios, 

designados por elementos, que se ligam entre si em pontos chamados nós. Assim, as soluções  
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são formuladas para cada elemento e a seguir são combinadas para obter a solução para o 

domínio geral (ALVES, 2007). Existem licenças do SAP 2000 disponíveis em várias 

Instituições de Ensino Superior.  

       Diante do exposto e tendo em vista a importância do SAP 2000 na complementação dos 

estudos dos graduandos em Engenharia Civil, desenvolveu-se um tutorial para análise de um 

pórtico 3D de concreto armado, estrutura muito comum no cotidiano dos estudantes e 

profissionais de Engenharia Civil. 

2. LANÇAMENTO DA ESTRUTURA NO SAP 2000 V. 18 

 

       O SAP 2000 analisa uma estrutura através da descrição do modelo estrutural. Os passos 

para a descrição do modelo estrutural seguem a definição das unidades padrões, objetos e 

elementos, classificação em grupos de objetos e elementos, verificação do sistema de 

coordenadas (x,y,z), determinação das propriedades dos elementos (seção, tipo de material), 

determinação dos casos de carregamentos (peso próprio e sobrecargas), casos a serem 

analisados, combinações, definições de projetos e definições de saída de 

dados.(VELOZA,2009). No presente tutorial a estrutura a ser analisada é um pórtico de 

concreto com dois pavimentos, três vãos na direção X e quatro vãos na direção Y. Os apoios 

são engastados. Na análise será considerado o peso próprio da estrutura e as sobrecargas da 

alvenaria de 5,07 kN/m e do piso de 1,5 kN/m², apresentando as seguintes características: 

material concreto com peso específico de 25 kN/m³; vigas e pilares com a mesma seção 

retangular (20 cm x 30 cm) com módulo de elasticidade E= 30 GPa; comprimento de vãos na 

direção X (4m, 4m, 5m) e na direção Y (4m, 4m, 3m, 3m); a altura do pé direito é 3 m e a 

espessura das lajes igual a 12 cm. 

 

2.1  Definição do modelo do pórtico 

 

       Ao iniciar o SAP 2000clicar no canto direito inferior da tela e mudar as unidades de 

medida para kN, m, C. Em seguida clicar emFile > New Model, para criar um novo modelo 

estrutural, selecionando a opção 3D Frameque significa pórtico 3D. Ao escolher o modelo 

3D Frame, será aberta uma caixa de diálogo onde se devem modificar os valores do pé direito 

(Story Height), numero de pavimentos (Number of Stories), número de vãos na direção x 

(Number of Bays, X), número de vãos na direção y (Number of Bays, Y), conforme apresenta 

a Figura 1, em seguida após a inserção dos valores do pórtico, selecionar a opção User 

custom Grid Spacing And Locate Origin > Edit  Gridpara localizar a origem do pórtico no 

plano espaciale marqueRestraints, isto é, determinar as restrições. 

       A seguir alterar os valores dos espaçamentos entre os vãos X Grid Data, de acordo com o 

projeto a ser analisado. Na direção X utilizar os vãos com valores de 4m, 4m e 5m. Na 

direção Y utilisar os vãos com valores de 4m, 4m, 3m e 3m. No primeiro quadro considerar o 

ponto A na ordenada 0 e ir somando as medidas dos vãos na direção X para determinar as 

ordenadas dos pontos B, C e D. No segundo quadro considerar o ponto 1 na ordenada zero e 

repetir o procedimento anterior para determinar as ordendas dos pontos 2, 3, 4 e 5, conforme 

Figura 2. 
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         Figura 1: Caixa de diálogo para entrada de dados do modelo estrutural de um pórtico. 
 

 
 

           Figura 2 - Caixa de diálogo para entrada dos dados dos vãos da edificação. 

 
 

3.  DEFINIÇÃO DAS PROPRIEDADES DA SEÇÃO DAS VIGAS DO PÓRTICO 

 

       Na tabela 3D Frame, clicar em Beams(+), que significa viga, para abrir a caixa Frame 

Properties. Em seguida altera-se as propriedades das vigas. Em seguida clicar em Add New 

Property, para adicionar novas propriedades. Nesse procedimento será alterado as seções das 

vigas do pórtico, selecionando a opção Concrete > Retangular, pois as vigas são de concreto 

e tem seção retangular de 20cm x 30cm. Em seguida indicar um nome para a seção em 

Section Name 
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e alterar as medidas da seção da viga para Depht=0,3 e Width=0,2, conforme Figura 3. 

 

      Figura3- caixa de diálogo para alterar a seção da viga. 

 

       Após abrir a caixa de diálogo Add Material Property, selecionar as opções: em 

Regionescolher User e em Material Type escolher Concrete. Em seguida clicar em Ok. Após 

inserir os dados na tabela anterior irá abrir a próxima caixa de diálogo Material Property 

Data, alterando o nome do material para concreto. Muda-se o peso especificoWeight per Unit 

Volume para 25 kN/m³ e o módulo de elasticidade Modulus of Elasticity para 30 x 106 GPa 

(30E6). Em seguida clicar em Ok. Após o programa retornar para a caixa de diálogo Material 

Property Data, deve-se selecionar o material criado (Concreto) e clicar em Ok.  

 

4.  DEFINIÇÃO DAS PROPRIEDADES DA SEÇÃO DOS PILARES DO PÓRTICO 

 

       Ao retornar para caixa de diálogo 3D Frame, selecionar (+) ao lado da opção Columns 

para alterar as secções e propriedades dos pilares do pórtico, conforme Figura 4.Após abrir a 

caixa de diálogo Frame Property clicar em Add New Property para adicionar a seção e as 

proprieades dos pilares. Pode-se mudar da seção para Pilar 20x30. Em seguida adicionar as 

dimensões do pilar (Depth 0,3 m ; Widht 0,2 m). 

Em Material clicar em (+) e selecionar o material concreto que já foi criado 
anteriormente. Por fim selecionar Ok. Ao retornar para caixa de diálogo 3D Frame, 

selecionar (Pilar 20x30) em Columns e confirmar clicando em Ok.Após ter realizado os 

passos anteriores e possível vizualizar o modelo estrutural, conforme Figura 5. Selecionar as 

vigas e colunasde 3, 4, 5 e A, B, C e apaga-las, pois são inexistentes no projeto a ser 

analisado. 
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         Figura4 - Caixa de diálogo 3D Frame,SAP 2000 v.18. 

 

                Figura 5 - Pórtico elaborado, imagem do SAP 2000. v.18. 

 

5.  DEFINIÇÃO DOS APOIOS DO PÓRTICO 

       Para se definir os apoios, selecionar os pontos que serão destinados aos apoios e na vista 

a direita (X-Y Plane @ Z=0), clicar nos pontos onde estão localizados os apoios do pórtico. 

Em seguidaaplicar os apoios e clicar emAssign > Joint > Restraints, que significa atribuir 

restrições comuns, e ao abrir a caixa de diálogo, selecionar o primeiro apoio com restrição em 

rotação e translação em todas as direções, pois todos apoios estão engastados, conforme 

Figura 6.  
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             Figura 6 - Caixa de diálogo para determinação dos apoios. 

 

6.  DEFINIÇÃO DAS LAJES E SUAS PROPRIEDADES. 

 

       Para criar as lajes da edificação selecionar o plano xy, e clicar na caixa de ferramentas 

Drawem seguida selecionar a opção Draw Rectangular Area.Em seguida, selecionar os 

pontos que deseja tornar uma área clicando nos vértices opostos de cadaretângulo que forma 

as lajes de cada pavimento, começando pela laje do 1° pavimento. A seguir são definidas as 

propriedades e seções das lajes, selecionando as mesmas por meio de um clique com o botão 

direito do mouse clicando a seguir em Define >Section Properties > Area Sections para 

definir as propriedades das seções das lajes,conforme a Figura7. Em seguida, selecionar Add 

New Section, que abrirá uma caixa de diálogopara inserir os dados da seção,Shell Section 

Data. Nessa caixa muda-se o nome da seção para Lajee em seguida os valores de Membrane 

e Bending para 0,12 m, ou seja, a espessura da laje é de 12 cm. Selecionar a opção Shell- 

Thin, isto é, casca finae escolher o material concreto. Por fim clicar em OK. 

                         Figura7- Barra de ferramenta Define. 
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       No projeto real há uma marquise. Para se desenhar as vigas das marquises do pórtico 

clicarem Draw > Draw Frame/ Cable/ Tendon. Em seguida prosseguir ao desenho das vigas 

e criação das lajes usando o mesmo procedimento anterior para criação das lajes dos 

pavimentos. Para modificar as propriedades e seções das lajes das marquises seleciona-se as 

áreas da marquise e em seguida clicar emAssign > Area > Sections e escolher a laje de 12cm 

já criada anteriormente.  

7.  INSERÇÃO DE CARGAS 

       Diante dos passos anteriores, basta inserir o carregamento. Para mudar os padrões de 

carga clicar em Define > Load Patternsadicionando-seAlvenaria >Other >1;Carga de 

Utilização > Other > 1; Piso > Other > 1, conforme Figura8. Em seguida cria-se uma 

combinação de cargas que irão atuar no pórtico. Essa combinação de cargas será usada na 

execução do programa para verificar os esforços atuantes devido a essa combinação. A Seguir 

clicar em Define > Load Combinations para definir uma nova combinação de cargas,e ao 

abrir a caixa de diálogo Load Combinations Dat, selecionar as cargas criadas. Para aplicar 

cargas as vigas da estrutura clica-se em Select > Properties > Frame Sections, selecionando 

assim as vigas que receberão as cargas de alvenaria, a qual foi calculada em 5,07 kN/m. Após 

a aplicação dessa carga, é possivel visualiza-la na estrutura conforme a Figura 9. 

  Figura8- Tabela para definir padrões de carga. 
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   Figura 9 - Pórtico com a força -5,07 kN/m distribuída, aplicada sobre a alvenaria. 

 

       Para aplicar cargas sobre as lajes deve-se clicar em select > poly que selecionará todas as 

lajes dos dois pavimentos e em seguida clicar em Assign> Area Loads > Uniform (shell para 

atribuir cargas as áreas selecionadas. As cargas aplicadas serão do piso e sua carga é de -1,5 

kN/m² na direção Z e a carga de utilização que é de – 4,0 KN/m², na mesma direção. 

Lembrando que a carga é negativa pois seu sentido é para baixo.  

8.  EXECUÇÃO E ANÁLISE DOS RESULTADOS 
 

       Após realizados os passos anteriores, pode-se prosseguir a análise da estrutura, clicando-

se emAnalyze > Set Analysis Optionse em Space Frame > Ok que selecionará as opções 

automaticamente para a análise do pórtico espacial. Em seguida irá surgir uma caixa de 

diálogo chamada Set Load Cases To Run para selecionar o conjunto de casos a serem 

executados. Vale ressaltar que é importante verificar se todas as ações estão em modo 

Runque é o modo de execução. Em seguida clicar em Run Now. Após a execução é possível 

visualizar a estrutura deformada na Figura 10 que é resultanteda combinação de 

cargas(Combo1) criada anteriormente. Para se visualizar os esforços cortantes clicar em 

Show/Forces Stresses >Frame/ Cables/ Tendons que irá abrir a caixa de diálogo Member 

Force/ Stress Diagram for Frame, selecionar as opções Force > Shear 2-2 para visualizar os 

diagrams de esforço cortante. 

       Clicando com botão direito do mouse em cima de uma viga ou pilar será exibido uma 

caixa de diálogo com os dados obtidos: forças nos apoios; esforços cortantes; momento fletor 

e deflexão máxima, conforme Figura 11. Clicando com o botão direito do mouse na viga 

destacada em vermelho do pórtico, observa-se o momento negativo no balanço e positivo no 

centro do vão da viga. 
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    Figura10 - Representação da deformação do pórtico após analise do sistema. 

 

Figura 11 - Caixa de diálogo com as informações da viga selecionada. 

 

       Para visualizar assolicitações máximas nas lajes deve-se clicar em Display > Show 

Forces/ Stresses > Shells, selecionando na caixa de diálogo as opções Shell Stresses > 

Maximum > S máx.Pode-se realizar a divisão das lajes em sub lajes, afim de se obter uma 

análise mais precisa. Para isso deve-se clicar em Select > Properties > Area Sections, para 

selecionar todas as lajes existentes na estrutura. Em seguida clicar em Edit Areas > Divide 

Areas e definir o número de partes que se deseja dividir a área. No presente estudo dividi-

seem 6(seis) partes em cada direção no comando Along Edge from Point 1 to 2 >6; Along 

Edge from Point 1 to 3>6.Em seguida se procede a análise da estrutura novamente clicando 

na aba Analyze > Run Analysis > Run Now. Clicando com o botão direito do mouse na 

vigaque se deseja analisar. será exibido uma caixa de diálogo com os dados obtidos: forças 

nos apoios, esforços cortantes, momento fletor e deflexão, conforme Figura 12. Caso se 

deseje apresentar as reações nos apoios clicar emDisplay>Show Forces/Stresses>Joints, 
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clicando com o botão direito do mouse no apoio desejado. 

            Figura 12- Esforços cortantes; momento; deflexão nas lajes. 

 

9.  CONSIDERAÇÕES FINAIS 

       O presente trabalhou mostrou que a partir de softwares como o SAP 2000 é possível 

simular, resolver e realizar cálculos a fim de buscar soluções para projetos. Para usar esse 

recurso tecnológico é necessário o conhecimento de prévio de disciplinas da área de estruturas 

e ter a capacidade de abstração para criar um modelo computacional a partir de um modelo 

real. O software pode plenamente ser utilizado como recurso tecnológico no processo ensino 

aprendizado de disciplinas como Resistência dos materiais, Estruturas de concreto armado, 

Aço, Estruturas de Madeira, Análise computacional de estruturas, entre outras, pertencentes à 

grade curricular dos cursos de graduação em Engenharia Civil.  
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A WRITING TUTORIAL SAP 2000 V. 18 FOR STRUCTURAL 

ANALYSIS OF A CONCRETE 3D FRAME 

. 
 

 

Abstract:The main aim of present work to present a tutorial of SAP 2000 v.18 - Structural 

Analisys Program, for structural analysis of a concrete 3D Frame. SAP 2000 is a software for 

structural analysis using the finite element method, developed by the American company CSI - 

Computers & Structures Inc. and marketed in Brazil by the company Multiplus Softwares 

Técnicos in. The software is widely used in structural analysis of small and large buildings As 

well as bridges, viaducts, dams, etc. Although it is an important tool of analysis, it is observed 

the difficulty of Civil Engineering students in the learning of such program as well as the 

shortage of material in Portuguese that presents in a didactic way some basic commands and 

tutorials of aid to use the program. Aiming to contribute to reduce these difficulties, the 

present work was developed, in which the analysis of a commercial two-floor building, 

constructed in concrete, was carried out to find the reactions in the supports, maximum 

values of deflection, bending moment and shear stress in Slabs, beams and pillars that 

composes the structure in order to study its behavior. 

 

 

Key-words: SAP 2000, Structural Analysis, 3D Frame. 

 
 

 


